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END USER LICENCE AGREEMENT
PLEASE READ THE FOLLOWING LEGAL AGREEMENT CAREFULLY PRIOR TO USING THE
VOCALIGN SOFTWARE PROVIDED WITH THIS AGREEMENT. USE OF THE SOFTWARE
CONSTITUTES YOUR ACCEPTANCE OF THE TERMS OF THIS LICENCE.
IF YOU DO NOT ACCEPT THESE TERMS, DO NOT USE THE SOFTWARE.
IF YOU HAVE PAID FOR THE SOFTWARE, RETURN IT TO THE RETAILER FOR A REFUND OR
CREDIT. If you cannot obtain a refund there, contact Synchro Arts Limited for information
about their refund policies.
THESE TERMS ALSO APPLY TO ANY SYNCHRO ARTS UPDATES AND UPGRADES FOR THIS
SOFTWARE UNLESS OTHER TERMS ACCOMPANY THOSE UPDATES OR UPGRADES.
1. Licence. The VOCALIGN plug-in, VOCALIGN CONTENT and other SYNCHRO ARTS LIMITED
software, video and audio accompanying this Licence, whether on disk, in memory or on any other
media (the "Software") and related documentation are licensed to you by Synchro Arts Limited. You
may use the Software on a single computer at a time. If you own a licence you can also install and
use the licensed software on secondary computers. However, you may not run the software
simultaneously on both the primary and secondary computers.
You may also transfer all your licence rights in the Software and related documentation and a copy of
this Licence to another party, provided the other party reads and agrees to accept the terms and
conditions of this Licence.
2. Copy and use restrictions. You are not allowed to distribute copies of the Software or the
documentation. This Software is protected by applicable copyright laws. It is illegal to give copies to
another person, or to duplicate the Software by any other means, including electronic transmission.
The Software contains trade secrets and in order to protect them you may not decompile, reverse
engineer, disassemble or otherwise reduce the software to human-perceivable form. You may not
modify, adapt, translate, rent, lease or create derivative works based upon the Software or any part
thereof. You acknowledge that no title to the intellectual property in the Software is transferred to you
and that title and full ownership rights to the Software will remain the exclusive property of Synchro
Arts Limited or its suppliers and licensors.
3. Termination. This Licence is effective until terminated. This Licence will terminate immediately
without notice from Synchro Arts Limited if you fail to comply with any provision of this Licence.
4. No Extra Warranties. SYNCHRO ARTS LIMITED GRANTS NO EXTRA WARRANTIES,
EXPRESS OR IMPLIED, BY STATUTE OR OTHERWISE, REGARDING THE PROGRAM AND
RELATED MATERIALS, THEIR FITNESS FOR ANY PURPOSE, THEIR QUALITY, THEIR
MERCHANTABILITY OR OTHERWISE.
5. Severability. In the event any provision of this Agreement is determined to be invalid or
unenforceable, it shall be adjusted so as to best reflect the intent of the parties to the maximum extent
possible, and the remainder of this agreement shall be valid and enforceable to the maximum extent
possible.
6. Entire Agreement. This Agreement is the entire understanding between the parties with respect to
the subject matter hereof and replaces any previous discussion and/or agreement regarding such
subject matter. No amendment to or modification of this Licence will be binding unless in writing and
signed by Synchro Arts Limited.
7. Governing Law. This Agreement shall be interpreted and enforced in accordance with English law
and the English courts shall have jurisdiction to determine any dispute.
Part of VocALign is developed and sold under licence from Wordfit Limited.
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Important Notes
•

In this manual, ‘VocALign PRO 4 VST / ARA’ will be referred to simply as ‘VocALign
PRO’ or simply ‘VocALign’.

Technical specifications
•

The VST instance of this program is compatible with Steinberg Cubase 4.5.2, 5 and
above, also with Nuendo 4.3 and above, running on Mac OS 10.6 and above, or on
Windows 7 and above. The ARA extension is compatible with Studio One Three,
Studio One Four, Cubase Pro (10.0.30 and later), Nuendo (10.1 and later), Cakewalk
(2017.02 and later) and Reaper (v5.97 and later)

•

For a full list of compatible DAWs (all versions of VocALign Pro) see
http://www.synchroarts.com/products/vocalign-pro/support

•

VocALign PRO 4 VST / ARA is a VST3 plug-in. It also contains an instance that
functions as an ARA I or ARA II plug-in.
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A. Introduction to VocALign
What is VocALign?
VocALign is a process that automatically edits the timing of one audio signal to match another.

How does VocALign work?
VocALign works by applying varying amounts of time stretching or compression to one signal
(called the ‘Dub’) to make its energy peaks and troughs align in time with a ‘Guide’ signal. It
does this in three main steps as shown in Figure 1.
VocALign analyses the Guide and Dub audio signals using identical spectrum analysers to
produce time-varying energy patterns. Then it uses advanced pattern recognition techniques
to examine the energy patterns and determine the best way to ‘warp’ the time structure of
the Dub signal so that its energy pattern is matched to that of the Guide. The time-warping
path describes the best time-distortion of the Dub for matching to the Guide. The timewarping path is fed to an audio editing processor that time-compresses and expands the Dub
audio to create the aligned version based on the path. It is this edited version of the Dub that
is returned to the audio editing software for the desired use.
Note: In the above diagram, the spectrum analyser colours match those used in the VocALign
screen for Guide and Dub audio signals and controls.

How can VocALign help?
If you are a dialogue editor needing to lip-synch vocals, or a music editor needing to tightenup lead or backing vocals, instrumental tracks, or perform a number of other alignment
tasks, then VocALign will help you.

Working without VocALign
A dubbing session for film post-production or music production begins with a guide track.
Then the voice-over artist, singer, or musician will dub this as closely as possible.
Because humans are not machines, they will not be able to get exactly in time with the
Guide. This is generally not acceptable for lip-synching, nor for double-tracking of vocals or
instruments. Often, the next step is to loop-record the trickier sections individually, but this
can break-up the natural flow of the line. Lastly, the editor will attempt manually to cut and
nudge individual sections of the new recordings into time with the Guide.
The above process can take many hours for both the artist and the editor.

Working with VocALign
The above process becomes a simple matter of getting the artist to concentrate on creating
a great performance, rather than worrying about the fact that it may drift in and out of exact
synch with a previous performance. VocALign can then be used to adjust the timing by
automatically time-stretching and compressing the material to allow the Dub to take on the
same timing pattern as the Guide.
1

This saves studio time, saves artists time and improves the quality of results. Most
importantly, artists are allowed to produce their best performances, free from the rigidity
normally associated with dubbing.

Figure 1 VocALign block diagram
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B. Applications
VocALign was originally designed for lip-synching replacement dialogue for film and video
post-production but it has been adapted to work successfully in the following applications:
•

Synching replacement dialogue in post-production for film and video.

•

Double-tracking vocal parts or instrumental parts

•

Tightening the ensemble of singers with one another, or with the lead vocal

•

Tightening the ensemble of backing instrumental tracks

•

Synching a drum machine audio-output to a real drummer (or vice versa)

•

Giving a dubbed vocal the timing of a ‘live’ vocal performance

•

Changing the voice or even apparent sex of a singer or actor’s performance

•

Replacing the vocals from a music video shoot with a production track, achieving perfect
lip-synch

•

Foreign language dubbing
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C. Basic and advanced operation modes
VocALign PRO 4 has two modes of operation: BASIC and ADVANCED.
In both modes VocALign automatically aligns the selected Guide and Dub audio regions, using
either time or frequency domain processing. In VocALign, you can trim the starts and ends of
regions to be processed and control the degree of flexibility in the time-warping (alignment)
process.
BASIC mode uses an alignment algorithm that has compatible behaviour to VocALign Project.
The ADVANCED mode uses a more sophisticated and robust alignment algorithm, which
generally results in more successful and accurate alignment. It also provides more flexibility
and control during the alignment process and may work better with audio signals that are
difficult to align in BASIC mode. In general, you should use ADVANCED mode unless you
specifically want the algorithm to behave like VocALign Project.
The ADVANCED mode adds two important controls: one that enables you to determine ‘synch
points’ and the other to select ‘protected’ regions in the audio to be aligned. Synch points are
pairs of pointers that relate specific locations in the Dub to specific target locations in the
Guide. VocALign will try to ensure that the points are put in synch. In essence this enables you
to attempt to ‘force’ VocALign to match the audio at these points. Protected regions are userspecified parts of the Dub audio that will not be affected by VocALign’s time warping.
VocALign PRO also includes frequency domain editing, in addition to the normal time domain
editing available in the VocALign Project version. This can be useful for getting good results
on single line melodic material such as solo singers or instrumentalists.
These features are covered in more detail later in this manual.
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D. Software installation and Authorization
Installation
If you have not already done so, download VocALign Pro 4 plug-ins from
www.synchroarts.com/downloads

Trial and Full Licences
VocALign Pro can run in a Trial Mode but it will require an iLok Trial licence which you can
obtain from the Synchro Arts website. Once you have obtained and installed the Trial
licence as described below, VocALign Pro will run in a fully functional demonstration mode
for the number of days stated in the information you receive with it.
VocALign Pro licences will authorize both Mac and Windows versions.
If you already have a VocALign Pro licence installed on an iLok USB Key that is plugged into the
computer running VocALign Pro, you can skip the rest of this section on authorization.

Software authorization summary
VocALign Pro uses the iLok system described on www.iLok.com for authorization.
IMPORTANT: Before you can run VocALign Pro, you must do all the following (if you
haven't already done so)
1. Create a free account on www.iLok.com
2. Go to www.iLok.com, download and install the new iLok License Manager on your
computer.
3. Run the iLok License Manager and sign in.
4. Synchro Arts normally supplies an iLok Activation code in the form:
XXXX-XXXX-XXXX-XXXX-XXXX-XXXX-XXXX-XXXX-XX

(where the X's are numbers)
note that this code is NOT a licence but an Activation Code that you can redeem in
the iLok License Manager to obtain your licence.
5. To redeem an Activation Code:
Open the 'Redeem Activation Code' window in the iLok License Manager.
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Enter your Activation Code as instructed.

If the code is recognized, you will see a VocALign Pro Licence in the iLok Manager.
Drag the Licence to your iLok USB Key.

iLok Keys can hold licences for a number of protected software products. You can have
licences from Synchro Arts and other software vendors on the same iLok.
If you followed the above procedures correctly, and the iLok Key with the relevant licence is
inserted in the computer running VocALign Pro, it should run in an authorized mode by
simply launching VocALign Pro
Reauthorizing VocALign Pro if the iLok is removed
If you subsequently try to run VocALign Pro without the iLok inserted into your computer you
will receive a warning message. Follow the instructions in the warning to reauthorize the
software.
WARNING: Do not remove the iLok from your computer while you are using VocALign Pro.
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E. Modes of operation
This version of VocALign Pro has three modes of operation, which operate differently
depending on whether you are using a VST3-only compatible DAW, or one that additionally
supports ARA, such as PreSonus’s Studio One or Cakewalk by Bandlab.
Please visit http://www.synchroarts.com/compatibility/editors/VocALign+PRO+4 for
information and videos about editors that support VocALign Pro.
Mode

Description

Method of capture
and alignment

Basic VST3

The plug-in works as an effect with
VST3-compatible DAWs that support
sends and sidechains (e.g. Cubase and
Nuendo). Processing is simply applied
to the track concerned with no
awareness of individual audio events.

Press “Capture”.
You must play
audio into VocALign
Pro in real time.

(see Sections F and G)
Cubase Pro, Cubase
Artist, Nuendo,
FLStudio, Adobe
Audition and Reaper
support this mode.

Align by pressing
“Process” in the
Useful if you want to work on a track as plug-in’s window.
a whole, or to control exactly what is
captured, rather than on individual
segments or events.
Fairly slow as the audio has to be
captured in real time.

ARA
(see Section H)
Studio One, Cubase
Pro, Nuendo,
Cakewalk and Reaper
support this mode.
ARA with Drag and
Drop
(see Section H)
Studio One, Cubase
Pro, Nuendo,
Cakewalk and Reaper
support this mode.

The plug-in works as an Event FX with
DAWs that support ARA (e.g. Studio
One or Cubase Pro/Nuendo) This
means that VocALign is applied to
specific audio segments or events.
Faster than Basic VST3 mode as the
audio is captured as quickly as possible.
Similar to ARA above. The plug-in
works as an Event FX with DAWs that
support ARA and Drag and Drop (e.g.
Studio One 3.3, Reaper 5.97, Cubase
Pro 10.0.30, Nuendo 10.1 or Cakewalk
(Sonar) 2017.2. All later versions of
these audio editors also support ARA
with Drag and Drop).
Usually the fastest method of working.
Capture and alignment are executed in
a single operation.
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Press “Capture” to
capture selected
audio events in
non-real time (as
fast as possible).
Aligns
automatically.
Drag audio events
onto the Guide and
Dub areas in the
plug-in’s window.
Aligns
automatically.
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F. Getting started (VST3: Cubase/Nuendo)
To learn to use the basic functions of VocALign PRO 4 only takes a few minutes. To
get the best understanding quickly we strongly recommend that you first follow the
brief tutorial in Section G, which uses prepared audio examples.
The following section is a Quick Start guide for those that want to jump straight in
without following the tutorial. Although the plug-in works with Cubase or Nuendo,
the text refers to its use with Cubase. The two user interfaces are very similar. (For
the ARA plug-in with Studio One or Cakewalk see Section H.)

Quick start
1

In the VST->Plug-ins page of Cubase’s Preferences, disable (untick) the setting
‘Suspend VST3 plug-in processing when no audio signals are received’.

2

In Cubase, add VocALign PRO as an Insert on the track to be aligned (the ‘Dub’
track) by selecting Other>VocALign Pro from the list of plug-ins that drops down
when you click on an available Insert slot, as shown in Figure 2 .

Figure 2 Selecting VocALign Pro as an Insert in Cubase
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Figure 3 VocALign window before audio capture

Figure 4 Turning on the side chain input

3

The VocALign plug-in window will open as shown in Figure 3.

4

Turn on the side chain input in VocALign by pressing the fifth button from the top
left of the plug-in’s window, as shown in Figure 4.

Now select a ‘Guide’ track in Cubase (the audio to which the Dub will be aligned) and route one of its
Sends to VocALign’s side chain on the Dub track. See Figure 5. Turn on the Send and set its gain to 0
dB.
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5

In Cubase, move its timeline (play cursor) to the beginning of the audio you want
to process. (The Guide and Dub audio should start at about the same time and
the starting point should be within low level noise before the start of the audio.)

6

Figure 5 Route a Guide track Send to VocALign's side chain

Figure 6 VocALign display after audio capture

7

In the VocALign window press Capture Audio. The light in that button will glow
yellow and show Stop Capture to show that it is waiting for audio. (You can
press it again to cancel the capture if necessary.)
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8

Press Play (space bar) in Cubase. The light in the button will flash green while
the audio is being captured. VocALign will record the Guide and Dub tracks while
Cubase is playing.

9

Press Stop in Cubase (space bar) when you reach the end of the Guide and Dub
audio. VocALign will then display the waveforms of the recorded audio in its
Guide and Dub windows (see Figure 6 above).

10

In the VocALign window select Advanced align mode, Time Domain editing and
Normal Flexibility (these are the default settings).
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Press Process and VocALign will align the Dub audio to the Guide audio. Once
the Dub has been aligned, the display will show the energy plots of the Guide
and Dub. You will also see a yellow trace above the Guide, which shows how the
energy of the Dub was matched to the energy of the Guide.

12

In Cubase move the play head back to the start of the Guide. Press Play in
Cubase and you will hear the aligned Dub along with the Guide.
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Use Cubase’s File->Expo->Audio Mixdown function to create an audio file of the
Aligned Dub. (See Figure 7.) Set Cubase’s location indicators so that they
highlight the region of audio that you want to mix down. Select the Dub track to
be mixed down then press Export to create the aligned file. This will be available
in Cubase’s Pool and can optionally be written to a spare track as part of the
mixdown process.

TIP: When you are aligning audio, try to make sure that:
•
•
•

The Guide audio content is sufficiently similar to the Dub.
The Guide starts at roughly the same time as the Dub.
The Guide and the Dub have a small lead-in (a quarter of a second to half a second)
containing a bit of background noise.

TIP: When you are exporting audio, make sure that the original tracks in Cubase are not
muted, faded down or solo’ed

12

Figure 7 Selecting Audio Mixdown as an Export option
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G. Tutorial (Cubase project)
This tutorial guides you through the use of VocALign Pro VST in easy stages, so that you can
learn about how it works and how best to use it. It uses a prepared Cubase project that can
be downloaded from the Synchro Arts website. (This can also be opened and worked on in
Nuendo, although for the rest of this tutorial it will be assumed that you are using Cubase.
The two user interfaces are very similar.) You will learn how to:
•

Select the Guide and Dub audio that will be processed in VocALign

•

Transfer the Guide and Dub audio into the VocALign plug-in

•

Use VocALign to create an Aligned (synchronized) Dub and audition it

•

Return the Aligned Dub audio to Cubase

Step 1 Obtain the tutorial project and audio
The Cubase project for the tutorial can be found by going to the following webpage at:
http://www.synchroarts.com/compatibility/editor-product/Cubase/VocALign+PRO+4.
Locate and click on the link Cubase VocALign Tutorial Project to download a copy of the
project to your computer.
Copy the contents to a suitable folder on your computer’s hard disk. The copied material
should contain the file and folders shown in Figure 8. The “.cpr” file is the Cubase project
file, and the folder Audio contains the two audio files used in this tutorial – ‘STEVEGUI.WAV’
and ‘TWITDUB.WAV’.

Figure 8 Contents of the tutorial project download

Step 2 Open the project in Cubase
When you open the project file in Cubase you may get a message that the project has been
moved (because Cubase thinks it was created somewhere else). Simply click on the button
New to select the location to which you have copied it as the project directory. The
displayed project should look similar to that shown in Figure 8. You may need to do a bit of
zooming and rearranging to fit your screen.
In the VST>Plug-ins page of Cubase’s Preferences, disable (untick) the setting ‘Suspend VST3
plug-in processing when no audio signals are received’. If this setting is enabled, then Cubase
will not replay the complete Aligned Dub when the Aligned Dub is longer than the original.
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Figure 9 Tutorial project display in Cubase
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Step 3 Add VocALign as an insert
In Cubase, add VocALign PRO as an Insert on the Dub (Audio 2) track by selecting Other
from the list of plug-ins that drops down when you click on an available Insert slot, and then
VocALign Pro as shown in Figure 10. The VocALign PRO window should appear as shown in
Figure 11.

Figure 10 Select VocALign Pro as an Insert in Dub track
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Figure 11 VocALign Pro plug-in editor window before audio capture

Step 4 Select the Guide audio as the side chain input
A side chain to the VocALign insert is used to connect the audio track that will be used to
guide the alignment process. Turn on the side chain input in VocALign by pressing the fifth
button from the top left of the plug-in’s window, as shown in Figure 12. The button will now
glow orange.
Now select the Guide track in Cubase and route one of its Sends to the side chain of the Dub
track Insert that controls VocALign, as shown above in Figure 13.

Figure 12 Turning on the side chain input
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Figure 13 Route a Guide track Send to VocALign's side chain

Figure 14 Setting the Send controls in Cubase

Turn the Send on and set its gain to 0 dB as shown above in Figure 14

Step 5 Set the start point in Cubase
In Cubase, select the start point of the audio you want to process, using Cubase’s time line.
(The Guide and Dub audio should be approximately in the same place.) In this case it means
dragging the time line back to zero (before the start of the audio extracts.

Step 6 Capture the audio
In the VocALign window press Capture Audio as shown in Figure 15 (next page). The light in
that button will glow yellow and show Stop Capture to show that it is waiting for audio. (You
can press it again to cancel the capture if necessary.)
Press Play (space bar) in Cubase. The light in the button will flash green while the audio is
being captured. The selected section of the Dub track will be loaded into VocALign. Press Stop
in Cubase (space bar) when you reach the end of the audio material to be captured. A pair of
waveforms will be displayed in the VocALign window showing the selected Guide and Dub
audio (see Figure 16, next page).
TIP: If you need to capture more than one audio region into one instance of VocALign, you
may need to use the Overview display at the bottom of the window to select separate regions
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for processing. Click on the desired waveform to select it. Use Delete to delete the selected
waveform from VocALign. This is covered in more detail in Section J.

Figure 15 Selecting Capture Audio (left) after which the light in the button glows yellow and shows ‘Stop Capture’ (right)

Figure 16 VocALign plug-in editor window after audio capture

Step 7 Prepare the settings for alignment
Select the Advanced alignment mode as shown in Figure 16 above, along with Time Domain
in the Editing menu to the right of it, and Normal Flexibility above and between these two
options. (These are the default settings.) This sets up the plug-in with some typical settings
for speech alignment.
In VocALign, if required, adjust the start or end of the Guide or Dub audio so that the
sections to be aligned are roughly similar in terms of content. This is done by clicking and
dragging the waveform from its ends (when first captured), or where it changes colour too
19

grey (after adjustment). The selection can also be made by sliding the blue or orange
pointers above or below the waveform, as shown in Figure 16. There is a pointer at the
beginning and at the end of each waveform to begin with. You may have to scroll to the
right in the VocALign window in order to see the pointers at the end of the waveforms.
Cubase’s transport commands are used to play the audio.

Figure 17 VocALign energy display after pressing ‘Analyze’

TIP: Try to ensure that the start of the audio selection is in ‘silence’ (which should be low
level noise within an audio segment, rather than an empty part of the track that lies
between segments) for about 0.25 seconds before the waveform energy appears. Try to
ensure the end of the selected audio is at the desired stopping point.

Step 8 Analyze the audio
In VocALign click Analyze. The display changes to show an energy plot of the Guide and Dub
tracks (Figure 17, above), which is what VocALign uses to create a time-warp path to match
the two extracts. (This step can be omitted because the Align or Process buttons will
automatically include the analysis step. The Analyze control is available to obtain a quick
overview of the anlaysis stage without further processing.)

Step 9 Align the Dub audio
Clicking Align creates a processed version of the track on which the VocALign plug-in is
inserted. You will now see a yellow trace superimposed on the Guide audio track’s
20

waveform (see Figure 18), which is VocALign’s proposed mapping of the Dub track’s energy
pattern to match that of the Guide. Initially VocALign saves its output to a temporary file,
but you can also create a more permanent audio file of the processed version.
(If you press Help then About in VocALign, you can see where the plug-in stores the
temporary audio files. You can also change the location of the folder for the temporary
files.)

Figure 18 Yellow trace over Guide showing proposed alignment

Figure 19 The Green loudspeaker shows that audio is ready to be played

Step 10 Create the time-aligned version of the Dub audio
Click Process to create a rendered version of the aligned audio that is written temporarily to
disk. The red loudspeaker (Not Ready) symbol next to the Delete button will change to
green (Ready), to show that the audio is processed and ready to be auditioned (see Figure
19 above).
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(While the loudspeaker symbol next to the Delete button is red – Not Ready – you won’t
hear the aligned audio from the track being processed. When the loudspeaker is green you
will hear the aligned audio.)
TIP: Generally, for the fastest operation, once the audio has been captured, press only the
Process button.

Step 11 Play the aligned audio
Once the edit is completed and the speaker symbol is green, if you press Play (space bar) in
Cubase (having moved the time line back to the start) you will hear both the Guide and
aligned Dub audio together in sync. If you left the
start and end pointers unaltered before editing,
the laugh at the end of the Dub audio will still be
audible and a little time-compressed. (VocALign’s
mapping of the two energy patterns, as shown by
the yellow trace, results in an overall shortening
of the Dub audio.)
The bypass button in the top left hand corner of
VocALign’s display (see Figure 20) allows you to
temporarily turn off the processing of this plug in
so that you can hear the original unprocessed
audio. The button is yellow when the plug-in is
bypassed. Be sure to turn bypass off (i.e. not
bypassed) if you want to use the Aligned audio.

Figure 20 Bypass button in VocALign editor window

If you move the Guide’s end marker (right hand blue pointer) to just after the end of the
Guide signal, then press Process again to regenerate the Aligned Dub, the laugh at the end
of the dub will be left unprocessed and will remain at the original speed.
You can also move the right hand orange pointer (the Dub’s end marker). For example, to
eliminate the laugh from the processed version, move the right hand orange pointer, so that
it is positioned just before the laugh starts. Press Process again and the laugh will be
removed from the aligned audio.

Step 12 Create an audio file of the aligned Dub
In order to create an audio file of the processed version (of the Aligned Dub), select the
Audio Mixdown function, which is under Export… on Cubase’s File menu, as shown in
Figure 21.
Set Cubase’s location indicators so that they highlight the time region of audio that is to be
mixed down. As shown in Figure 22(next page), this is done by dragging the small triangular
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markers at the top of the
time bar above the audio
tracks, so that one is at the
start and one at the end of
the region. If none exist,
you can make them by
moving the cursor into that
area of the time bar until
the cursor turns into a
pencil, then clicking to
create a location indicator
that can then be dragged.
The mixdown options are
shown in Figure 23. Under
Channel Selection on the
left, choose the Dub audio
channel only. The new
region can be named in the
box at the top of the
‘Export Audio Mixdown’
window (shown here as
Figure 21 Audio Mixdown selected from Export options under the File menu
‘TWITDUB_aligned’) and a
path (folder location) for
the new file chosen. You can set various file saving options according to the needs of your
project. A mono downmix would be the normal option for VocALign processing. If you tick
Audio Track in the ‘Import into Project’ at the bottom, the processed region will be bounced
onto a new track in sync with the start of the original one, as well as being made available in
Cubase’s Pool.

Figure 22 Setting Cubase’s location indicators to highlight the region for mixdown
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Figure 23 Cubase’s audio mixdown options

Make sure the original tracks in Cubase are not muted, faded down or solo’ed, then press
Export. The aligned file will then be created and written to an audio track. In Figure 24you
can see the new ‘TWITDUB_aligned’ track with the fitted version of the Dub audio. If you
play it along with the Guide track these should be in sync (mute the unprocessed Dub track
first)
TIP: Do not save the modified Cubase tutorial session over the original downloaded session
when exiting Cubase, so that it can be used again. Save the modified one with a different
name.

Figure 24 The newly aligned Dub track has been mixed down to track 3 in Cubase
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Step 13 Using advanced features of VocALign Pro
VocALign Pro has a number of advanced features that enable you to control the way VocALign
aligns material. Guidance on the use of ‘synch points’ and ‘protected regions’ is given in
Section K. Section J also includes a few tips and tricks for effective operation.
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H. Operation as an ARA plug-in
The VST3 version of VocALign Pro contains an ARA-compatible extension that will work with
DAWs that support ARA such as Studio One, Cubase Pro, Nuendo, Reaper or Cakewalk.
This section explains how to use VocALign as an ARA plug-in with audio editors that support
ARA, such as Studio One. Apart from this, other detailed and advanced aspects of the plugin’s operation are the same as for the VST version described in the remainder of this manual
(except that the bypass function does not operate in the ARA version).
Unlike the VST3 version, the ARA version can load audio into the VocALign plug-in quickly
without needing to take audio from an insert and load it in real-time. For most audio editors
such as Studio One or Cubase Pro, VocALign needs to be added to each clip of audio (Audio
Event) as an effect (Event Fx), whereas others such as Reaper, VocALign can also be added
as a track effect (Fx).
The basic steps below describe how to use VocALign as an ARA plug-in in Studio One. The
steps for using VocALign in the other audio editors are almost identical, apart from the first
step, which describes how to add VocALign Pro to a track or region of audio (an Audio Event).
Click here to add VocALign to audio events in Cakewalk.
Click here to add VocALign to audio events in Cubase Pro (or Nuendo).
Click here to add VocALign as a Track Fx in Reaper.

Add VocALign to Audio Events in Studio One
In Studio One VocALign is added to an Audio Event as an Event FX. Select all the Guide and
Dub audio events in Studio One that you want to process, then from Studio One’s Audio menu
select Edit with VocALign (shown in Figure 25 below). This will add VocALign Pro to all the
selected audio events.

Figure 25 VocALign Pro is added as an Event Fx using Edit with VocALign in Studio One’s Audio Menu

TIP: To speed this step up you can assign a keyboard shortcut (Studio One->Keyboard
Shortcuts…) to the menu entry Edit with VocALign.
There is also a Remove VocALign entry in Studio One’s Audio menu that will remove
VocALign Pro (if it has been added) from selected audio events. You can also assign a
keyboard shortcut to Remove VocALign.
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Click here to continue to the next step (Select and process the audio).

Add VocALign to Audio Events in Cubase Pro (or Nuendo)
In Cubase Pro (10.0.30 and later), VocALign is added to an Audio Event as an extension. First,
in Cubase select all the Guide and Dub audio events that you need to process. From Cubase’s
Audio menu choose Extensions and, in the menu that appears select VocALignPro (shown in
Figure 26 below). This will add VocALign Pro to all the selected audio events.

Figure 26 VocALign Pro is added as an Extension from Cubase’s Audio Menu

Note: There is also a Remove Extension from Selected Events entry in Cubase’s Extension
menu that will remove VocALign Pro (if it has been added) from all selected audio events.
Once you have added VocALignPro as an audio extension to an audio event, Cubase will
show the symbol in the event’s top right corner and the event’s ARA filename between
parentheses. Cubase will also open VocALign Pro in its editor window.

Figure 27 Adding VocALign Pro to the audio events BG_GUIDE, BG-DOUBLE and BGVOICE3.
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Click here to continue to the next step (Select and process the audio).

Add VocALign as a Track Fx In Reaper
In Reaper you need to add VocALign as a Track Fx to each track that contains the Guide audio
and the Dub audio. In the example below the first track contains the Guide while the second
and third tracks contain the Dubs
For each of the first three tracks follow these steps in Reaper:
a) For Track “STEVEGUI”, click the track’s “Show Track Fx Window” button.

Figure 28 Opening the Track Fx Window in Reaper

b) In the “Add Fx To:” dialogue box, choose VST3 in the column on the left. To see the

"Add Fx To:" dialogue box you may need to click the Add button in the FX window.

Figure 29 Adding VocALign Pro to Track 1 “SteveGui”.

c) From the list of VST3 plug-ins in the "Add FX to:" window, select VocALign Pro and
then press the OK button.

28

d) Once you have added VocALign to the track, Reaper will display each plug-in labelled

with the name of its associated track. In this example its label is “Track 1: LEAD VOX
1".

Figure 30 VocAlign Pro as an Fx insert in Track 1 “SteveGui”.

e) Similarly, add VocAlign Pro to Track 2 and Track 3 by repeating steps a) to d) for each
of these tracks.

To remove VocALign Pro from a track, click the track’s Fx button to open its Fx window,
select VocAlign Pro in the column on the left and then click the “Remove” button.

Click here to continue to the next step (Select the process the audio).

Add VocALign to Audio Events in Cakewalk (Sonar)
In Cakewalk, VocALign is added to an Audio Events by creating a Region FX.
In Cakewalk, apply VocALign Pro as a Region FX to the Guide and Dub audio events. To do this,
select the Guide audio event, then from the Region FX menu select VocALignPro->Create
Region FX. Repeat the process for each Dub audio event.
Tip: It is possible to speed this step up by first selecting multiple audio events in Cakewalk and
then creating a Region FX from the selection.
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Figure 31 VocALign Pro is event added to the selected audio clip(s) by creating a Region FX.

There is also a Remove Region FX entry in Cakewalk’s Region FX menu that will remove
VocALign Pro (if it has been added) from selected audio events.

Select and Process the Audio
For this section we are using Studio One as an example, but the steps needed to process the
Dub audio are exactly the same in the other editors listed in this manual.
First, in Studio One select the Guide audio, which in this example is BG-GUIDE on the first
track. Next in VocALign press the button “Capture Guide”.

Figure 32. Capturing the Guide audio BG-GUIDE in VocALign Pro.
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Once you have captured the Guide, VocALign will display the selected audio in its Guide
display.

Figure 33. Guide audio in VocALign Pro

Now to Capture the Dub audio, select the audio event BG-DOUBLE in Studio One and press
the button “Capture Dub”.

Figure 34 Capturing the Dub audio BG-DOUBLE in VocALign Pro.

Once VocALign has captured the Dub audio, it will automatically align the Dub to the Guide
using the current settings.The display will show the energy profiles of the original audio and
the energy profile of the Aligned Dub superimposed on the Guide’s. The small loudspeaker
icon will glow green to indicate that VocALign has generated audio file for the aligned Dub.
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Figure 35 VocALign Pro displays the energy profiles of the Guide (blue) and Dub (orange). The yellow trace shows the energy
profile of the Aligned Dub.

You may alternatively use Drag & Drop if your DAW supports it (please see below).

Play and render the aligned audio
If the Playback Ready indicator below the Dub track on the plug-in’s display is green, you
can play the tracks concerned in Studio One. You should hear the aligned version of the
audio event instead of the original one. This, however, is only a temporary “effect” applied
to the audio event in real time.
To “render” the aligned audio permanently in Studio, first select the Dub audio event, then
press Render on the audio event’s Event FX information panel (Figure 36). This is normally
visible at the bottom of the left side of Studio One’s main display, if the Inspector (press F4)
is enabled in the View menu.
To “render” the aligned audio in Cakewalk, first select the Dub audio event that you want to
make permanent, then from the Region FX menu select VocALignPro->Render Region FX.
Once you have rendered the audio event, the audio event’s original audio will be replaced
with the aligned audio.
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Figure 36 Press Render in Studio One for the VocALign effect on the Dub track to be rendered as new audio on the Dub track

TIP: Unless you render the aligned audio, it will continue to be applied as a real-time effect,
using processing power, unless the effect is turned off. This means that you will continue to
hear it as it was originally aligned, even if you edit the original audio. To avoid any such
confusion, render the effect before changing any audio in Studio One and it will then replay
reliably. You can Restore the real-time effect after rendering in Studio One if you change your
mind.

Reopening the VocALign plug-in window
If you have closed the VocALign plug-in window and want to access it again to change the
settings or realign audio, make sure the effects applied to the track are visible by clicking on
the Event FX button in the Inspector, to show the down arrow, then double-click the
VocALign Pro effect name in the Event FX info panel shown above.

Capturing multiple Guide/Dub events
To capture more than one pair of Guide/Dub events in VocALign simply repeat the steps for
the first pair, namely:
1. Add VocALign as an Event FX to the pair of events. (In the case of DAWs that use
Track FXs such as Reaper, you need only add VocALign to the tracks that have the
Guides and Dubs. When VocALign is added as a Track FX, it will have access to all the
track’s audio).
2. In the DAW select the Guide audio and in VocALign press the button Capture Guide.
3. In the DAW select the Dub audio and in VocALign press the button Capture Dub. This
step both captures the Dub and aligns it to the Guide automatically using the current
settings.
4. If necessary, in VocALign make adjustments to the settings to improve the alignment
and press the button Process.
5. Repeat steps 1 to 4 for each new pair as required…

Displaying a Specific Dub Audio Event in VocALign
If you have used VocALign to process many Dub Events in a Studio One Song you may want
to display a specific Dub/Guide pair. To do this, simply click on the Dub or Guide Event in
Studio One and VocALign will display that Dub/Guide pair in its window.
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Multiple instances of VocALign
It is possible for more than one instance of VocALign to be added as an Event FX in Studio
One. These only show up in the drop downs at the top of the plug-in window. As you should
generally only have one at a time, remove the others using Remove in the drop-down
(Figure 37).

Figure 37 Remove multiple instances of VocALign in the plug-in window

Drag & Drop operation
If your DAW supports ARA with Drag & Drop (e.g. Studio One v3.3 or Cakewalk v2017.02,
Reaper 5.97, Cubase 10.0.30, Nuendo 10.1 and later versions of these DAWs) the entire
capturing and processing operation can be performed much more quickly.
1. Make sure you have already applied VocALign Pro as Event FX (or Track FX) to all the
events that you want to use as the Guide and Dub, as shown in the first step in this
section.
2. Select all the audio events on one track that form the Guide signal, and then Drag and
Drop the selection onto VocALign’s Guide track in the plug-in’s window.
3. Select all the audio events on one track that form the Dub signal, and then Drag and
Drop the selection onto VocALign’s Dub track in the plug-in’s window. (Multiple Dubs
can be dropped at the same time. Each Dub in this case may be formed from audio
events on the same track)
4. The Dub(s) will be automatically aligned to the Guide using the current settings.
5. If necessary, make any adjustments to settings that may be needed to improve results
and press Process again.
Please Note: All the audio events that form the Guide (or each Dub) must be on the same
track and be adjacent to each other. In other words, there can be no silence or overlaps
between each audio event and the audio events must be next to each other. See Figure 38
below.
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Figure 38 Selecting the Guide and Dub(s). In this example, the audio events BG-Guide1, BG-Guide2 and BG-Guide3 could be
selected to form the Guide. Likewise, BG-Voice3a and BG-Voice3b could be selected as one Dub and BG-Double as another.

Changing the plug-In’s settings
In the ARA version of VocALign Pro you will find a Settings button at the top left of the plugin window. It enables you to change how audio events are described in the drop-down
menus for Guide and Dub selection.

Figure 39 Options in the Settings menu of the ARA plug-in

Display Times in bar beats allows you to change the format of the displayed times to bar
beats. VocALign will use the current setting of the project’s beats per minute.
Show starting times of audio in its displayed name enables you to choose whether the
starting times of events are shown with its name. (This can help to distinguish between
copies of events with the same name located at different playback times.)
Check for similar starting times when capturing Guide and Dub checks that the events
being captured have similar starting times in the session. This checks the suitability of the
Guide and Dub for correct alignment, and guards against capturing unintended events.
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Show only the selected Guide and Dub enables you to choose whether VocALign shows
only the selected Guide and Dub in its Guide and Dub graphs.
Normally the selected Guide and Dub are shown highlighted and all the other captured
Guides and Dubs are shown at a reduced brightness. Dub signals that overlap or are close to
each other can make the graphical displays a little confusing. Selecting this setting will make
it easier to see what you are currently processing.
If there is no selected Guide or Dub, then VocALign will always show all its captured audio at
a reduced brightness.

Capturing audio in real time using Basic VST mode (as an Insert Effect)
Although VocALign Pro can capture audio events almost instantly in ARA mode using the
Event FX methods described above, it can also be operated in Basic VST mode (see Section E).
The plug-in is used as an Insert on the Dub track and the audio is captured in real time while
playing. This can allow for finer control over what is captured as you can select the exact start
and end points required.
The basic steps to be followed here are almost identical to the Cubase introduction given
above:
1. Add VocALign Pro as an Insert to the Dub track audio event by dragging it from the
Effects browser onto the event concerned (don’t hold down ALT in this case). As a
result, the plug-in is added as an Insert effect rather than as Event FX.
2. Take a Send from the Guide track and route it to the VocALign side-chain input.
3. Adjust the Send level on the Guide track, normally to 0 dB and turn on the Send.
4. Locate the playback cursor in the DAW at the start of the material to be captured.
Press Capture Audio in the plug-in. Play the audio in the DAW. Stop playback. Press
Stop Capture.

36

I. VocALign PRO 4 screen contents and controls

Figure 40 Key to VocALign screen contents and controls (VST version shown, see previous section for explanation of
differences with ARA version)

1) Bypass button: bypasses any VocALign processing applied on this Insert. If bypass is OFF
(grey), VocALign will play the aligned Dub, if the aligned Dub is ready (i.e. indicator (31) is
green). If bypass is ON (yellow), VocALign will play the original (unprocessed) Dub audio.
(VST only.)
2) Capture Audio button: arms VocALign to receive Guide and Dub audio from the editor
during a play pass. (Yellow when waiting for audio, flashing green when capturing audio.)
3) Side chain button: turns on the side chain input to VocALign (normally routed from a
Send of the Guide track). (Orange when ON.)
4) Help button: click to access help tips.
5) Display start time and time offsets – shows position of captured audio referenced to the
editor time line.
6) Aligned audio trace: a representation of the energy of the new aligned signal.
7) Guide energy: a profile of the energy of the Guide signal in time. Display elements
relating to the Guide are coloured blue.
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8) Guide start point selector: adjusts processing start. (The corresponding end point
selector is shown further to the right).
9) Synch point pair: click in this region and drag the green blobs to create and adjust pairs
of synch points (see Section K).
10) Dub start point selector: adjusts processing start. (The corresponding end point selector
is shown further to the right).
11) Dub energy: a profile of the energy of the Dub signal in time. Display elements relating
to the Dub are coloured orange.
12) Protected region (see Section K).
13) Protected region start and end markers: drag the red sliders to mark regions that will
remain unaffected by processing (see Section K).
14) Scroll bar: use slider to move waveform position in window.
15) Align button: click this to generate and display the aligned Dub audio energy trace in
Guide window (does not create aligned audio).
16) Analyze button: click to analyze and display the energy plot of the Guide and Dub.
VocALign displays the energy in only one band (500Hz – 1kHz) but actually splits it into
four bands.
17) Overview window: shows multiple captured regions. If more than one independent
audio region has been captured these will be shown as separate waveforms in the
Overview display area. Clicking one of them selects the Dub and Guide waveforms to be
processed. Selected waveforms are highlighted in bright blue and orange, whereas
unselected waveforms are dimmed.
18) Selected Guide waveform: Guide audio that will be processed.
19) Selected Dub waveform: Dub audio that will be processed.
20) Advanced/Basic mode selector menu. Use Advanced mode unless you specifically want
compatible behaviour with the Project version of VocALign.
21) Unselected Guide waveform: Guide audio that will not be processed (shown as darker
waveform). (These will only be visible if multiple regions occurring at different time
values have been separately captured into the plug-in.)
22) Unselected Dub waveform: Dub audio that will not be processed (shown as darker
waveform). (These will only be visible if multiple regions occurring at different time
values have been separately captured into the plug-in.)
23) Overview waveform display scrolling: slide to move display.
24) Automatic synch point setting: press to let VocALign pick possible synch points.
25) Clear synch points: press to delete all synch points.
26) VocALign settings controls the characteristics of the alignment processing (see Section
J).
27) Editing basis: click to choose between time and frequency basis for non-linear time
compression and expansion.
28) Process button: click to generate aligned audio. (31) will indicate when done.
29) Delete button: click to remove the selected waveforms from VocALign.
30) Overview waveform display scaling: slide to zoom in and out.
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31) Editing complete indicator: If the indicator is green (‘Ready’), the edited (aligned) audio
has been processed and is ready for playback. If the indicator is red (‘Not Ready’), the
aligned audio is not yet ready to be replayed.
32) Selected waveform display scaling: slide to zoom in and out.
33) Energy scale: shows range of display.

J. Important tips for effective operation
Assuming you have mastered either the Quick Start introduction or the Tutorial in the
previous sections, the following will help you to get the best results from VocALign. The text
refers to use with Cubase, but the in most cases the same principles apply when used with
other supported DAWs.

Cubase/Nuendo Preferences
•

In the VST>Plug-ins page of Cubase’s Preferences, disable (untick) the setting
‘Suspend VST3 plug-in processing when no audio signals are received’. If this setting
is enabled, then Cubase will not replay the complete Aligned Dub when the Aligned
Dub is longer than the original.

•

On the same Preferences page, you may wish to set Cubase’s preferences so that the
plug-in editor window is always on top.

Capture
•

In Cubase, you will start with a session in which there is Guide (original) audio
contained on one track and Dub (replacement or new) audio on a second track.

•

In the Cubase Project window, drag the time line (current play time) so that it starts
just before the desired portion of the Guide and Dub audio regions for processing.
The captured material can include any individual region or multiple regions. Your
selection can begin and end in the middle of a region. (To have this fine control over
start points with the ARA version, you will have to use it in Insert mode, as described
in Section G, or adjust the Guide start point selector in VocALign once the audio is
captured.) VocALign PRO works best when working on relatively short regions at a
time, for example from 20 seconds to, say, a minute. But effective alignment will
depend on many things: e.g. gaps in the signals, how similar they are and other
features. Some experimentation will help the user find the best lengths to process
for each signal.

•

Try to capture up to around 0.25 to 0.5 seconds of ‘background’ or ‘leader’ audio at
the beginning of your Guide audio selection. This will assist VocALign to set the noise
floor levels and allow better alignment at the start of the signal. (In the current
version of VocALign PRO 4 VST, the selected audio can be up to five minutes long
and must be longer than 0.25 seconds.)

•

The Dub does not have to start at the same time as the Guide. In other words, the
timecode position of the Dub is not used. The Guide’s timecode is important and so
is the amount of ‘background’ captured before the Guide and the Dub.
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•

Try to leave as much or slightly more background audio before the start of the Dub
signal than there is before the start of the Guide.

•

If you capture an audio region that begins in digital silence, VocALign may generate
an error as it needs to be able to detect a signal to enable it to set its analysis
parameters. Try to start capturing where there is at least some low level background
noise within the audio region.

Overview window

Figure 41(a) Overview display showing dimmed waveform (to the right) for unselected audio that is separate in time from the
selected audio. (b) Showing overlapping regions that have been separately captured

•

If you capture more than one audio region (in separate capture passes) while the
VocALign plug-in is open these will show up as separate waveforms in the overview
window at the bottom of the display. Click on the section of the waveform that you
want to align, and it will appear in the upper displays ready for processing. The
unselected regions’ waveforms are dimmed as shown in Figure 41(a) above. In this
case the two regions occupy separate periods in Cubase’s timeline, so it is easy to tell
them apart in the overview window.

•

Selected (highlighted) waveforms in the overview window are those that will be
processed by VocALign. If you press Delete only the highlighted waveform will be
deleted.

•

If you have accidentally or intentionally captured more than one region (in separate
capture passes) within the same period on Cubase’s timeline, one will be overlaid on
the other(s) in the overview window, as shown in Figure 41(b). The latest captured
one will be highlighted, and the other(s) will be dimmed. If they overlap completely
you will not be able to see those lying behind and the only way to reveal the hidden
material is to delete the highlighted material this is hiding it. Nonetheless, if part of
the dimmed waveform is visible in the background, you can click on it to select it.

Trimming the captured material
•

Captured audio material may need to be trimmed before alignment in order to
ensure that the extracts are optimised for processing. VocALign will work best if
Guide and Dub material start at a similar point in their energy profiles, and both have
a small period of background noise before they begin.

•

It is preferable to trim starts and ends of extracts using the energy display. You can
help VocALign do a better job by trimming the audio to match initial energy profiles
40

and ensure that there is a good chance of starting the alignment accurately. To
convert a captured audio waveform into the energy display press Analyze.
•

IMPORTANT: There is currently no way to return to the waveform display once an
energy analysis has been done. The current contents must be deleted and
recaptured if you need to start again.

•

You can optionally perform several operations on the energy display waveform itself
before alignment:

a) The start and end boundaries of the selected regions can be modified by dragging
the blue or orange pointers at either end of the audio selections as shown in Figure
42, left. The waveform turns grey to indicate unselected audio energy. Alternatively,
you can position your cursor at the boundary of the coloured audio material (the
cursor changes into a pair of
horizontal arrows) and drag
the boundary left or right.
b) The display can be scrolled
horizontally with the scroll
bars to examine the captured
waveforms. You may need to
scroll right to see the end
point adjuster.
c) The scale control ( Figure 42,
right) can be used to expand
or contract the horizontal
time scale (slider) or alter the
range of the vertical scale in dB
(+) (–).

Figure 42 (left) Pointers to adjust start of Guide and Dub energy;
(right) scale control

Alignment
•

Choose an appropriate VocALign setting before pressing Align (e.g. if the Dub is very
long compared to the Guide, try ‘Maximum Compression’). Guidance is offered in
the following section ‘Alignment settings.

•

After clicking Align, visually inspect the results in the Guide window. The peaks and
troughs of the yellow (Aligned Dub) energy trace should line up generally with those
of the Guide as in Figure 43.

•

If the alignment looks satisfactory, generate the aligned audio by pressing Process.
This creates the aligned audio.
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Figure 43 Checking the aligned energy (yellow trace)

•

A shortcut is to simply press Process after capturing the audio as this will run the
Analyze and Align steps first.

•

Preview the results by using the Cubase play controls.

•

If the alignment is satisfactory, transfer the edited audio to Cubase by using the
Audio Mix down function, as described in the tutorial.

•

If you make any changes to the selected waveform or settings after the initial
alignment, the yellow trace of the aligned signal will disappear, and the Editing
complete indicator will glow red. After having made any changes, simply press the
button Process to regenerate a new aligned output.

•

If the alignment does not look or sound satisfactory, there are a few options:
a) Select another setting or alignment mode (which will clear the aligned trace),
click Align again, and examine the results.
b) Adjust the ‘leader’ audio before the start of the Guide and Dub to be roughly
equivalent, with the Dub leader being slightly longer.
c) Adjust the end of the Guide or Dub (see previous section).
d) Reselect and recapture the Guide or Dub audio in Cubase, if the original
selection is thought to be causing the problem.

Figure 44 Selecting alignment setting
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Alignment settings
You can control the alignment settings, which greatly affect how the alignment performs.
Use the alignment settings menu to select which preset is active, as shown in Figure 38
above. The main setting characteristics are described in Table 1.
Setting

Main characteristics

Low Flexibility

Alignment is not very flexible, sound quality may be
best.

Normal Flexibility

(Default): it is recommended to try this first as it works
best in most cases.

High Flexibility

Alignment is the most flexible of the settings, but may
compromise sound quality.

Maximum Compression

Tries to match the Guide by time compressing the
aligned audio as much as possible.

Maximum Expansion

Tries to match the Guide by time-expanding the
aligned audio as much as possible.

Table 1 Alignment settings

In general, you will achieve better results by selecting the ADVANCED alignment mode. BASIC
mode is provided to offer compatible behaviour with the Project version of VocALign.

Editing modes
VocALign PRO offers two methods of editing the Dub audio. The differences are highlighted
in Table 2.
Editing mode

Optimum
requirements

signal

Advantages

Speed
editing

Frequency

Audio contains only a single
pitch. (e.g. one voice or one
single – pitched
instrument)

Good for reducing editing
artefacts in transients and
rapid pitch changes when
expanding.

Slower

Time

Audio can be single voiced
or contain complex signals.

Good for compression and
maintaining musical beat.

Fastest

of

Table 2 Editing modes

Further tips and tricks
Latching
To align just the start of the Dub with the Guide (and leave the rest of the Dub unprocessed),
use the Guide End Point Selector to use only select 0.25 to 1.0 second of the Guide audio for
processing and keep the Dub signal full length.
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Reverb tails
To stop the end of a Dub from being stretched to wrongly match a noisy or reverberant Guide,
stop the end of the Guide for processing to be 0.25 to 1.0 second before the Guide signal of
interest ends and use the entire Dub.
Controlling the plug-in status (VST version)
After having first added VocALign as an Insert on a Cubase track, the name of the plug-in will
appear on the relevant Insert slot. To change or remove the plug-in, click and hold on the
Insert slot and select the appropriate plug-in (or ‘No Effect’). To reopen the VocALign window
once the plug-in window has been closed, click on the round button in the Insert controls
containing an italic ‘e’ to open the plug-in editor window.
Previewing material
Once the Dub track has been provisionally aligned (before mixing down the aligned audio to
an audio file) you can listen to either the Guide track or the Dub track separately by using the
track mute or solo controls in Cubase. Mute the Guide track to hear only the Dub track, for
example. Use the Bypass control in VocALign to turn on or off the alignment effect. Remember
to remove these modifications before mixing down a processed track.
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K. Advanced mode operation
Synch points
Synch points are used to pick target points where VocALign will try to ensure that the two
extracts remain in synch. In essence this enables you to attempt to ‘force’ VocALign to match
the audio at these points. Synch points are created as pairs (displayed as linked green pointers)
– one relating to the position in the Guide and one relating to the position in the Dub audio.
You can move each point in the pair independently of the other, so that the synch point can
be different in the Guide and Dub tracks.
Synch points can be set either automatically or manually. In this example (Figure 45) from the
speech material at the beginning of the tutorial audio, automatic synch point selection was
chosen. The display shows one synch point detected where a particularly high energy peak is
present in both versions. The plug-in attempts to match alignment at this point, adjusting the
sections before or after it separately. A shading change is shown at the synch point boundary.
You can add synch points manually by clicking in the synch points area between the start and
end selection pointers, then dragging the green pointers to the appropriate locations. In the
example (Figure 46), two synch points have been manually inserted.
Synch points can be deleted by right- or control-clicking (Mac single button mouse) on them.
They can all be deleted at once using the Clear button.

Figure 45 Automatically selected synch points shown in green

Figure 46 Manually inserted synch points
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Protected sections
Sections of the Dub track can be protected so that they are not edited by VocALign. Click in
the ‘Protect’ bar below the Dub display to add a red pointer at the start of the intended
section, then drag it to highlight (in red) the relevant area.
The example in Figure 47 uses the material from the tutorial examples. Here the phrase
‘unreal time’ has been protected so that, after processing, it remains spoken in the rather
more languid way used on the Dub track, as opposed to being shortened as on the Guide
track. This can be useful, for example, in foreign language dubbing when you want to avoid
inappropriate modification of certain words in the dubbed language.
Drag the pointers to alter the starts and ends of the protected section, remembering to
press Process again in order to perform a new alignment. Click and drag again in the same
bar to add further protected sections. Red pointers can be deleted by right- or controlclicking on them.

Figure 47 Selecting a protected section using the red sliders
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L. Troubleshooting
For help and advice, visit the Synchro Arts support website at:
http://www.synchroarts.com
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